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1 Plan et organisation de l’UE

1.1 Organisation
1.1.1 Enseignants :

Benoit Eble (1 groupe), Andrea Ciardi (1 groupe), Dirk Stratmann (1 groupe, responsable
de l’UE), Gary Mamon (remplacements), Wilfrid DA SILVA (1 groupe)

1.1.2 Buts de l’UE :

. Apprentissage des éléments de base de Mathematica avec un fort accent sur le calcul
symbolique et les plots.

. Montrer des applications en trois domaines : les maths, la physique et l’informatique.

. Ces deux points devront permettre aux étudiants de devenir autonome à l’utilisation
de Mathematica, afin qu’ils puissent l’utiliser comme outil précieux lors de leur études
(et au-delà).

1.1.3 Organisation de l’UE :

1. 12 séances de cours-TD de 2h le mercredi à partir du 21 janvier jusqu’au mercredi 8
avril dans les salles info de l’UTES à l’Atrium.

2. Toutes les séances de cours-TD sont obligatoires, les abscences doivent être justifiées
avec un certificat à déposer au secrétariat.

3. Chaque étudiant travaille individuellement sur son propre poste.

1.1.4 Évaluation des étudiants :

1. A la fin de chaque séance, chaque étudiant doit déposer son notebook Mathematica sur
SAKAI (boite de dépôt de l’étudiant) en tant que compte rendu. Les comptes rendus
comptes 40% de la note finale. Les comptes rendus ne seront pas corrigés individuelle-
ment et il n’y aura pas de correction générale des cours-TD.

2. Quatre C.C. de 30 min environ lors des séances de cours-TD. 60% de la note finale. Les
C.C. seront fait en général sur machine et feuille.

1.1.5 Ressources :

. SAKAI :
http://australe.upmc.fr/access/content/group/1XM02_01/

. Un bon livre surtout pour les applications en math :
http://australe.upmc.fr/access/content/group/1XM02_01/livres/Hazrat_Mathematica_AproblemCenteredApproach.pdf

1.2 Plan des cours-TD
Voici la liste des cours-TD qui peut encore changer en cours de route :
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Partie I : Mathematica
1. Introduction à Mathematica et l’utilisation des variables
2. Éléments de langage Mathematica
3. Listes et simplification d’expressions

Partie II : Mathématiques et Mathematica
4. Limites, dérivées, primitives, vecteurs et matrices + CC partie I
5. Développements limités et résolution d’équations
6. Étude de fonction
7. Équations différentielles ordinaires

Partie III : Physique et Mathematica
8. Projectile dans le champ de pesanteur + CC partie II
9. Pendule simple et autres exemples de physique

Partie IV : Informatique et Mathematica
10. Traitement de données + CC partie III
11. Intégration numérique, programmer avec Mathematica
12. Traitement d’image d’astrophysique + CC partie IV

2 Introduction à Mathematica

2.1 Introduction
Mathematica est un logiciel de calcul formel et numérique développé par Wolfram Re-

search. Il permet essentiellement de faire du calcul formel (manipulation d’expressions mathé-
matiques sous forme symbolique, par exemple : calcul de dérivées, de primitives, simplification
d’expressions, etc...) et du calcul numérique (évaluation d’expressions mathématiques sous
forme numérique ; par exemple : calcul des premières décimales du nombre p ,évaluation
approchée d’intégrales, etc...). Mathematica incorpore un langage de programmation sophis-
tiqué et permet aussi de faire des graphiques. C’est un logiciel très utilisé en enseignement,
dans la recherche scientifique et dans l’industrie.

2.2 Liens vers d’autres tutoriels/cours
2.2.1 Wolfram Education Portal

Sur le Wolfram Education Portal :
https://education.wolfram.com/
qui est assez récent, on trouve des cours de math et physique niveau lycée et supérieur. Ces

cours sont enrichis avec des applications (“Widgets”) ou démos de Mathematica. A essayer
et surveiller, car ça évolue encore.

Wolfram a aussi fondé cette initiative pour promouvoir l’utilisation de l’ordinateur (avec
Mathematica ;-) ) dans l’apprentissage des maths dès l’école :

http://www.computerbasedmath.org/
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2.2.2 Livres numériques disponible à l’intérieur de l’UPMC :

Le point d’entrée pour chercher qc dans les bibliothèques papier ou numérique est Jubil :
http://www.jubil.upmc.fr

En haut à droite sur la page d’accueil on peut directement chercher un livre papier ou
numérique (Rechercher dans le catalogue).

Alternativement si on cherche uniquement des livres ou revues numériques on peut choisir
à gauche Ressources en ligne>Les livres numériques, puis la recherche 2. dans la liste
A-Z des e-books est plus adaptée si on connait déjà le titre.

Pour une introduction à Mathematica d’un point de vue de mathématicien le livre de
Hazrat est très intéressant, car il utilise Mathematica pour résoudre des problèmes mathé-
matiques autour des nombres :

. Hazrat : “Mathematica : A Problem-Centered Approach”
Ce livre est également disponible sur SAKAI :

. http://australe.upmc.fr/access/content/group/1XM02_01/livres/Hazrat_Mathematica_AproblemCenteredApproach.pdf
Pour ceux qui veulent voir de quoi Mathematica est capable, il y a le livre de Wagon, qui a
un niveau assez haut :

. Stan Wagon : Mathematica in action

2.2.3 Livres papier disponible dans les bibliothèques de l’UPMC :

Une bonne référence très complète pour les physiciens est :
. Patrick T. Tam : A Physicists guide to Mathematica

Une introduction courte à Mathematica et très accessible est donné dans ce livre, qui applique
Mathematica pour faire des calculs numérique de trajectoire de systèmes simples jusqu’au
chaos :

. Marvin L. De Jong : Mathematica for calculus-based physics
Un livre un peu ancien, mais avec beaucoup d’exemples et exercices sur Mathematica :

. Abell et Braselton : Mathematica by example
Une série de livres en français, qui utilise Mathematica d’une manière très approfondie pour
faire des maths assez poussés (niveau prépa) :

. Jean-Pierre Xémard : Mathematica théorie et pratique en 4 tomes (Applications en
arithmétique, en Analyse, en géométrie et en algèbre)

2.3 Utiliser Mathematica chez soi et dans les salles de l’UTES
2.3.1 Se loger dans les salles de l’UTES

Il faut se loger sur la session “Bureau de l’UTES” (première entrée) dans les salles de
l’UTES. Le login est votre login étudiant habituel. Avec cette session vos fichiers seront
gardés sur votre compte personnel (indépendemment de la machine utilisée) et vous pouvez
même les reprendre depuis chez vous (voir en bas). ATTENTION : faire quand même des
sauvegardes de vos fichiers en dehors de l’UTES et SAKAI, il est déjà arrivé à un étudiant
de perdre les deux en même temps !
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Remarque : Sous Windows, le raccourci clavier Alt + Maj change le clavier de AZERTY
en QWERTY ou vice versa, si jamais les deux claviers sont installés sous Windows, ce qui est
le cas avec la session sans login "Mathematica" dans les salles de l’UTES. C’est un problème,
car on utilise Alt+Maj+7 ou 9 pour changer le type d’une cellule. Pour cela le conseil :
N’utiliser que la session "Bureau de l’UTES" (première entrée) dans les salles de l’UTES, qui
a d’ailleurs l’avantage qu’on garde les fichiers grâce au login.

2.3.2 Sans installation : Bureau de l’UTES

Si vous êtes sous Windows, vous pouvez utiliser Mathematica via une connexion Inter-
net sans rien installer chez vous. Il suffit pour cela d’aller sur le bureau de l’UTES :
http://lutes.upmc.fr/ts/

et suivre les instructions (aide via ?) pour ouvrir votre bureau de l’UTES à distance.
Une fois sur le bureau de l’UTES, il faut choisir PEDAGOGIE (en haut à droite), puis
MATHEMATIQUES, puis plus bas dans la liste dans la rubrique LOGICIELS DE
CALCUL on trouve MATHEMATICA.

>�>�> Pour lancer Mathematica directement dans les salles de l’UTES il faut faire la
même chose !

La connexion à distance est aussi un moyen pour récupérer / travailler sur vos fichiers
crées lors des cours-TD dans les salles de l’UTES.

Actuellement il n’y a uniquement la version 9 de Mathematica à l’UTES.

2.3.3 Avec installation : MonUPMC

L’UPMC a une licence globale permettant d’installer Mathematica sur tous les ordinateurs
d’enseignement. En particulier, il est disponible sur les ordinateurs du L’UTES (Bâtiment
Atrium), y compris ceux en libre service. La licence globale permet également aux ensei-
gnants et aux étudiants d’installer Mathematica sur n’importe quel ordinateur personnel (à
la maison). Pour cela, connectez vous sur le site https ://mon.upmc.fr, allez dans la rubrique
"Outils", puis suivez les instructions pour télécharger et installer Mathematica. L’activation
se fait par un mot de passe et nécessite l’appartenance à l’UPMC.

La version actuelle en téléchargement est la version 10 qui a quelques fonctionnalités en
plus de la version 9 disponible à l’UTES.

3 Organisation de Mathematica et Raccourcis clavier

3.1 Noyau et interface graphique
Mathematica est composé de deux parties : le noyau ("kernel") et l’interface graphique

("front end"). Le noyau constitue le cœur du logiciel ; il interprète les instructions d’entrée
(écrites en langage Mathematica), puis calcule et retourne le résultat. L’interface graphique
s’occupe de l’interaction avec l’utilisateur. Elle gère le fichier de travail (souvent appelé "feuille
Mathematica" ou "notebook"), permet de taper les instructions et de visualiser les résultats.
Le logiciel dispose aussi d’un traitement de texte, permettant ainsi d’inclure du texte parmi
les calculs effectués. Plusieurs palettes d’outils sont disponibles pour aider à l’édition aussi
bien de textes que d’expressions mathématiques (voir menu "Palettes").
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3.2 Fichier Mathematica = Notebook (*.nb)
Un fichier Mathematica, aussi appelé "notebook", a une extension ".nb". Il est structuré

en cellules ("cells"). Une cellule est constitué d’une ou de plusieurs lignes et est repérée
par un crochet à droite du fichier. On peut avoir des cellules contenant des instructions
Mathematica (indiqué avec "In"), des résultats de calculs (indiqué avec "Out"), du texte, un
titre de paragraphe, etc ... Une cellule peut contenir plusieurs sous-cellules, formant ainsi des
groupes structurés de cellules. Pour faciliter la lecture du fichier, on peut ouvrir ou fermer
des groupes de cellules en double-cliquant sur le crochet correspondant (ou en cliquant sur
le triangle à gauche du titre).

. Pour créer un nouveau notebook utiliser le raccourci clavier Ctrl+N (appuyer sur Ctrl
et N en même temps, d’abord Ctrl ensuite N en plus) et pour le sauvegarder : Ctrl+S

. Dans cette UE on essaye d’utiliser Mathematica surtout avec la clavier et le moins
possible avec la souris, ceci vous permets d’être plus rapide et nous pouvons vous
donner des explications plus concises. C’est pour cela que la fiche Raccourcis clavier
doit être utilisée à chaque séance dès le début.

3.3 Mon premier calcul en Mathematica
On crée un nouveau notebook avec le raccourci clavier Ctrl + N (appuyer sur Ctrl et N

en même temps, d’abord Ctrl ensuite N en plus). Dans ce notebook, on tape une instruction
(par exemple "1+2"), puis on l’exécute en maintenant enfoncé la touche "Maj" ou "Shift" (⇑)
et en appuyant sur la touche "Entrée" (←↩), le résultat ("3") s’affichant sur une nouvelle ligne.

Après exécution, la ligne d’instruction est désignée par "In" suivi du numéro de l’ins-
truction depuis le démarrage du noyau. La ligne de résultat est désignée par "Out" suivi du
numéro de l’instruction correspondante.

Le noyau ("kernel") de Mathematica est démarré lors du premier calcul. Si un calcul prend
trop de temps et que l’on décide d’y renoncer en cours d’évaluation, on peut utiliser le menu
"Evaluation", puis "Abort Evaluation". Parfois, il peut être également utile de quitter puis
redémarrer le noyau, afin d’effacer de la mémoire tous les résultats des calculs précédents.
Pour cela, on utilise le menu "Evaluation" puis "Quit Kernel". Le noyau sera alors redémarré
lors du prochain calcul.

1. Créer un nouveau notebook et essayer les raccourcis clavier de la partie Cellules et Édi-
tion de la fiche Raccourcis clavier. Le but est créer plusieurs cellules et de pouvoir les
sélectionner, copier, coller, effacer sans utiliser la souris.

4 Documentation de Mathematica
Toute la documentation fournit par Wolfram sur Mathematica est exclusivement en an-

glais. Mais même avec des connaissances d’anglais de base on arrive à tirer profit de cette
aide, car elle très riche en exemples. D’ailleurs comme l’anglais est omniprésent dans notre
vie (Internet, logiciels, publications scientifiques, livres en anglais, ...), il serait dommage de
ne pas pouvoir profiter de ces ressources à cause des lacunes en anglais. Par exemple, il existe
des livres en français sur Mathematica, mais le choix est plus grand en anglais et souvent les
livres en anglais sont écrit d’une façon plus accessible ou pédagogique. Alors profitez de cette
UE de Mathematica aussi pour améliorer votre niveau d’anglais si nécessaire.
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4.1 Documentation Center
Depuis le menu Help on peut accéder au Documentation Center (raccourcis clavier :

touche F1). Dans la fenêtre qui s’ouvre on trouve en haut une barre de recherche ainsi que
trois icônes à gauche de la barre de recherche. On peut savoir plus sur ces icônes en laissant
le pointeur de la souris immobile sur un des icônes. Les trois icônes sont :

1. Home : retour au point de départ dans le documentation center
2. Function Navigator : similaire au Documentation Center, mais les thèmes sont or-

ganisés un peu différemment. En cliquant sur les triangles on ouvre/ferme les sous-
rubriques et en cliquant sur le nom on ouvre l’aide correspondante dans le Documen-
tation Center. Le Function Navigator ne semble rien apporter de plus par rapport
au Documentation Center à part le fait qu’il organise la même aide d’une façon hié-
rarchique à trois niveaux ou plus, tandis que le Documentation Center n’a que deux
niveaux hiérarchie.

3. Virtual Book : comme un livre numérique sur Mathematica. Regroupe tous les tuto-
riels et les “How to” (instructions pas à pas). En cliquant sur les triangles on ouvre/-
ferme les sous-rubriques et en cliquant sur le nom on ouvre l’aide correspondante dans
le Documentation Center.

2. Chercher la fonction sin dans l’aide de Mathematica. L’aide de Mathematica est interactif :
on peut changer directement les exemples dans l’aide. Changer un paramètre d’un exemple
(lignes avec In) puis lancer l’évaluation de cet exemple avec Maj+Entrée, la ligne Out en
dessous devrait être changée.

3. En dessous des exemples on trouve quatre autres catégories d’aide : See Also, Tutorials,
More About (Related Guides en version 9) et Related Links. Regarder par exemple
More About>Trigonometric Functions.

4. Ouvrir le Virtual Book et survoler le chapitre Introduction>Getting Started. Comme on
peut voir (voir barre de recherche) il s’agit ici de l’aide de type tutorial. Ensuite survoler le
chapitre Mathematics and Algorithms>”How to” Topics>Do Basic Calculations.

4.2 Aide depuis un notebook
On peut aussi obtenir de l’aide directement depuis un notebook.

5. Dans un notebook vide tapper Sin, placer le curseur sur Sin, puis appuyer sur la touche F1
du clavier (Mac OS X : cmd+Maj+F ou encore Fn+F1 sur des portables). La même aide
qu’on avait obtenue dans l’exercice précédente devrait apparaitre.

6. Placer un ? devant Sin ( ?Sin) puis évaluer la cellule avec Maj+Entrée, une aide sommaire
devrait apparaitre directement dans le notebook. En cliquant sur >�> on ouvre le documen-
tation center sur Sin.

4.3 Wolfram Demonstrations
Wolfram Demonstrations Project (http://demonstrations.wolfram.com) regroupe presque

10000 démos de documents interactives Mathematica pour visualiser et expérimenter avec
une large collection de sujets. Ils montrent les fonctionnalités dont Mathematica est capable,
même si la création d’une telle démo par soi-même est assez compliqué et hors programme
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pour cette UE. Néanmoins leur utilisation permets de mieux comprendre un sujet en mathé-
matiques, physique, chimie, biologie, etc.

7. Essayer cette démo : http://demonstrations.wolfram.com/WorldMapProjections/
Comparer la carte Mercator (une carte bien connue) avec {CylindricalEqualArea, 0}
(surfaces y sont fidèles)

5 Mathematica comme système de calcul symbolique
ou numérique

5.1 Calculs arithmétiques simples
Comme avec une calculatrice, on peut bien sûr faire de simples calculs arithmétiques avec

Mathematica. Nous avons déjà vu l’exemple d’une addition.
8. Voici un exemple d’un calcul avec une soustraction (-), une multiplication (*) et une division

(/) sur des nombres décimaux (à taper dans un notebook) :
. (10.2 - 3.1)*6.2/2.9

Voici l’exemple d’un calcul avec une puissance (la touche ^ est à côté du P sur le clavier et
le symbole n’apparait seulement quand on a tapé 4) :

. 2^4
Par défaut, Mathematica simplifie les fractions mais ne donne pas de valeur décimale :

. 4/6
Pour avoir une valeur décimale approché d’une expression, on peut utiliser la fonction "N"
en donnant l’argument entre crochets (touche Alt Gr + 5 ou ° (à côté de 0)) :

. N[4/6]
Pour calculer une valeur de la fonction sinus (attention au majuscules !) :

. Sin[Pi/4] ou encore N[Sin[Pi/4]]

5.2 Calculs arithmétiques plus compliqués
9. Si on n’utilise pas la fonction “N”, Mathematica donne des résultats exactes sans approxi-

mation ou arrondi :
. Comparer 3^100 avec N[3^100] et 3.0^100

Les calculs symboliques qui donnent des résultats exactes peuvent prendre beaucoup plus de
temps dans certains cas que les calculs numériques qui donnent des résultats approchés :

. Comparer 3^10^8 ; // Timing avec 3.0^10^8 ; // Timing
10. D’avoir des résultats exacts est utile pour par exemple vérifier que

26824404 + 153656394 + 187967604 = 206156734

Cet exemple contredit une conjecture d’Euler disant que trois nombres de puissance quatre
ne peuvent jamais sommer à un autre nombre de puissance quatre. Il a fallu 200 ans pour
que ce premier contre-exemple a été trouvé, par Noam Elkies de Harvard en 1988 (voir le
livre de R. Hazrat, “Mathematica : A Problem-Centered Approach”).
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. Comparer le résultat exact de (2682440^4 + 15365639^4 + 18796760^4) avec 20615673^4
Un autre exemple trouvé dans le livre de R. Hazrat, qui démontré la capacité de Mathematica
de gérer des nombres avec une quantité de chiffres très grandes :

. 2^9941-1
Si un nombre du type 2n − 1 est un nombre premier, on l’appelle un nombre premier de
Mersenne. En 1963, Gillies a trouvé que 29941 − 1 est un nombre premier de Mersenne.
Mathematica permets de vérifier cela avec la fonction “PrimeQ” (prime number = nombre
premier, Q pour question) :

. PrimeQ[2^9941-1]
Comparer les deux résultats :

. 2^9941 - (2^9941 - 1)

. N[2^9941] - (N[2^9941] - 1)

6 Écrire un rapport interactif avec Mathematica

6.1 Introduction
On peut écrire un rapport interactif avec Mathematica en ajoutant des éléments de texte

explicatifs directement dans le notebook. On parle de rapport interactif comme un notebook
peut contenir des éléments dynamiques comme des animations ou encore desManipulate (voir
TP 2). Un notebook peut être exporté en format CDF (computational document format) de
Wolfram, un format qui peut être lu par tout le monde un fois un lecteur gratuit du format
CDF installé. On peut alors distribuer ses rapports écrits avec Mathematica à des personnes
qui n’ont pas une licence pour Mathematica.

Pour éviter de confondre les cellules de texte avec les cellules de type Input/Output, il est
très utile de changer le style du notebook via le menu Format>Stylesheet>Report>Standard
Report. Ce style distingue bien visuellement entre les cellules de type Input/Output et du
texte.

6.2 Types de cellules : Input/Output, Texte, Titres, Sous-titres,
...

Pour changer le type d’une cellule, regarder dans la liste des raccourcis clavier le point
Type de cellule. Le plus souvent on a besoin de changer entre du texte (Alt+7) et le
Input (Alt+9). Pour vérifier le type d’une cellule, activer la barre à outils dans le notebook
(Menu Window>Show Toolbar). Le type d’une cellule sera affiché en haut à gauche dans
le notebook. ATTENTION : ne pas modifier le type d’une cellule avec le menu déroulant de
cette barre à outils, vous risquerez de mélanger les types à l’intérieur d’une même cellule.
Toujours utiliser les raccourcis clavier pour modifier le type d’une cellule.

En plus du texte simple on peut aussi mettre des titres et sous-titres (voir raccourcis
clavier).

Pour pouvoir corriger vos comptes rendu de TP qui seront en forme de notebook Ma-
thematica, il est impératif de mettre au moins le numéro de l’exercice en question à laquelle
vous répondez et si possible aussi un peu de texte explicatif.
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11. Mettre en forme et commenter votre notebook des exercices précédentes avec des titres et du
texte.

6.3 Commentaires
Alternativement au changement de type de cellule, on peut aussi ajouter des commentaires

dans des cellules de type Input sans changer le format de la cellule avec
(* commentaire *)

6.4 Exporter
On peut exporter un notebook en entier dans d’autres format comme PDF, CDF ou tex via

le menu File->Save As (Ctrl+Maj+S) en choisissant un autre type de ficher dans la liste sous
Save as type : On peut par exemple exporter le notebook en PDF simplement en choisissant
PDF Document (*.pdf) dans cette liste. Si on veut garder la possibilité de pouvoir interagir
avec le document ou garder les éléments dynamiques (animations, Manipulate, ...), il faut
choisir Computable Document (*.cdf). Ces fichiers peuvent être ouvert avec un lecteur
gratuit, le CDF player, disponible sur le site de Wolfram.

On peut aussi exporter uniquement une partie du notebook, par exemple pour enregistrer
un plot on fait un clique-droit avec la souris sur plot pour ouvrir le menu contextuel puis on
choisit Save Graphic As... Le format par défaut est PDF pour les graphiques, comme il
représente le graphique d’une manière vectorielle et non en bitmap (agrandir ce PDF pour
voir l’effet). Alternativement on peut aussi directement copier&coller le graphique (Ctrl+C
puis Ctrl+V) pour le mettre dans Word par exemple.

Les formules s’exportent aussi individuellement, soit avec copier&coller pour Word, soit
avec le menu contextuel (clique-droit) puis Copy As pour LATEX ou LYX par exemple.

6.5 Présentations avec Mathematica
Il est possible de créer des présentations avec Mathematica. Comme ce sujet dépasse les

objectifs de cette UE, on vous renvoie vers l’aide de Mathematica : Dans la barre de recherche
du Documentation Center entrer : howto/CreateASlideShow

6.6 Correcteur orthographique
Malheureusement Mathematica n’a pas de correcteur orthographique pour le Français,

mais uniquement pour l’Anglais (Menu Edit->Check Spelling...).

7 Définition et utilisation de variables ou d’expressions
en général

7.1 Exemples de code Mathematica
Tous les exemples de code Mathematica montrés dans l’énoncé ne contiennent que des

cellules de type Input. C’est pour cela que c’est indispensable de tester ces exemples soi-
même avec Mathematica. Chaque ligne d’un exemple est une nouvelle cellule de type Input
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et doit être évaluée dans l’ordre. Les exemples peuvent être copié&collé (Ctrl+C puis Ctrl+V)
dans Mathematica depuis la version PDF de l’énoncé présent, mais attention de séparer la
commande Quit dans une cellule à part.

7.2 Introduction
En Mathematica le nom d’une variable doit respecter à peu près les mêmes règles que

dans d’autres langages de programmation, comme ne pas commencer avec un chiffre (ex :
2x) et ne pas contenir des caractères spéciaux (ex : %, #, {, [) ni des accents. Un nom de
variable ne peut pas contenir des espaces. En Mathematica il ne peut non plus contenir des
underscores (tiret bas) (ex : x_point), car ce symbole est réservé. Toutes les expressions
(variables, fonctions, ...) qu’on définit soi-même doivent commencer avec une minuscule pour
éviter une confusion avec les expressions déjà définies de Mathematica, qui commencent
toutes avec un majuscule, par contre on peut mettre des majuscules ailleurs qu’au début
(ex : xPoint). Mais attention ’xPoint’ est différent de ’xpoint’.

Le signe = permet d’affecter une valeur à une variable. Tester ces exemples et observer
le changement de couleur des variables. Qu’est-ce qu’indique la couleur noir ? et la couleur
bleue ?

x=3
y=4
x^2 + y^2
Sqrt[x^2 + y^2]

Ouvrir un nouveau notebook (Ctrl+N). Par défaut les variables de l’ancien notebook
seront aussi connues dans le nouveau (voir Annexe pour changer cela). On peut tester cela
tout simplement en évaluant le nom de la variable :

x
y

Normalement l’évaluation de ces deux inputs renvoie les valeurs données en haut. Si
l’évaluation de ces deux inputs renvoie le nom de chaque variable, alors ces deux variables
ne sont pas encore définie soit en général soit dans le notebook actuel (voir Annexe).

Pour ne pas devoir ouvrir un nouveau notebook avec chaque nouveau exemple, il est for-
tement conseillé de commencer tout nouveau exemple avec la commande Quit. La commande
Quit permet de redémarrer le Kernel et donc d’effacer toute la mémoire sur les variables déjà
définies dans tous les notebooks.

Si on ne veut pas que le résultat de l’évaluation d’une cellule Input soit affiché ou encore
si on veut mettre plusieurs instructions sur une même ligne, on utilise le point-virgule. Tester
ceci (ATTENTION mettre Quit dans une cellule à part qui sera évaluée en premier) :

Quit
x
x=3; y=4;
x
y
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L’ordre des évaluations des cellules est très important. L’ordre est indiqué par les numéros
après In et Out. Essayer cet exemple :

Quit
x^2 + y^2
x=3; y=4;

Dans cet exemple, la cellule x^2 + y^2 doit être évaluée en dernier, autant la placer en
dessous des autres cellules. D’une manière générale il est préférable de placer les cellules dans
l’ordre de l’évaluation, au moins après avoir terminé les essais et erreurs dans un notebook.

7.3 = ou :=
En plus du signe = pour l’affectation immédiate, il existe aussi le signe :=. Tester ces

deux exemples pour comprendre la différence entre = et := (attention à bien respecter l’ordre
des évaluations d’en haut en bas, ligne par ligne) :

Quit
x=5; y=x+2;
y
x=10
y
?y

Changer le y=x+2 en y:=x+2 donne un autre comportement :

Quit
x=5; y:=x+2;
y
x=10
y
?y

Qu’est-ce qui a changé ?
On voit bien ici que le signe = affecte la valeur de x+2 à y, tandis que le signe := définie

la règle comment on obtient y avec n’importe quelle valeur de x. Les deux opérateurs, =
et :=, ont une direction : du côté droit vers le côté gauche (left hand side (lhs) et right hand
side (rhs) en anglais), par exemple on ne peut pas écrire 5=x. La différence entre = et := est
à quel moment donné rhs est évalué :

. lhs = rhs rhs est évalué immédiatement et le résultat est copié à lhs

. lhs := rhs rhs est évalué à chaque fois que lhs est utilisé
Comme dans le premier exemple la valeur de x est déjà connue au moment de l’affectation
y=x+2, le rhs x+2 est évalué et donne 7. C’est cette valeur qui sera copié sur y et non x+2.
Le fait de changer x après coup ne change rien à y qui est toujours égale à 7. La commande
?y à la fin donne plus d’information sur la définition de y.

Si on veut que y dépende de x tout le temps, on peut utiliser le signe :=. Mais il est
possible aussi d’avoir cette dépendance avec le signe =, comme montré dans cet exemple :
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Quit
y=x+2
x=5
y
x=10
y
?y

On voit ici que y est égale à x+2 et non à une valeur, car au moment de l’affectation x
n’a pas encore de valeur, donc l’évaluation de x+2 donne x+2. Du coup à chaque fois que la
valeur de x change, on obtient une autre valeur pour y.

Un autre exemple qui illustre la différence entre = et :=. Pour savoir ce que fait la fonction
Random[], placer le curseur sur Random[] puis appuyer sur F1.

Quit
x=Random[]
x
x
x:=Random[]
x
x
x

Ces exemples ont seulement un but pédagogique ici. S’il y a une dépendance entre deux
variables, il est préférable d’indiquer la dépendance d’une variable sur une autre en écrivant
une fonction.

7.4 ==
Comme le signe = est déjà utilisé pour l’affection, on teste avec un double signe égal ==

l’égalité entre deux expressions. Par exemple :

Quit
x=3
x==6
x==3

Le résultat du teste d’égalité est donné en valeur booléenne, soit True (Vrai), soit False
(Faux).

7.5 Substitution avec règles
Au lieu de définir des variables globalement pour tout le notebook on peut aussi remplacer

localement une variable par une valeur sans jamais faire une affectation du type x=2. Ce
remplacement est effectué avec une règle qui s’écrit : x -> 2. Il suffit d’appliquer cette règle
à l’expression souhaité avec l’opérateur /. (qui correspond à la fonction ReplaceAll) :
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Quit
x + y /. x -> 2
x

Comme on voit dans cet exemple, x est remplacé dans l’expression x + y par la valeur 2,
sans affecter réellement une valeur à x.

Si on veut remplacer plusieurs variables à la fois, on utilise une liste de règles :

Quit
x + y /. {x -> a, y -> b}

La fonction Solve permet de résoudre des équations et fournit les solutions sous forme
d’une liste de règles. Pour convertir cette liste de règles en liste de valeurs, il suffit de l’ap-
pliquer à la variable des règles, ici à x :

Quit
solutions = Solve[x^3 - 2*x + 1 == 0]
x /. solutions

7.5.1 ReplaceRepeated

L’opérateur /. ou la fonction correspondante ReplaceAll applique les règles qu’une seule
fois à l’expression. Ceci peut être observé avec cet exemple, car il reste un y après l’application
des règles :

Quit
x + 2*y /. {x -> y, y -> a}

Si on veut que les règles soient appliquées plusieurs fois, jusqu’à ce qu’aucun remplacement
n’est plus possible, on utilise la fonction ReplaceRepeated ou encore l’opérateur //. Essayer
l’opérateur //. sur l’exemple au dessus pour voir l’effet.

ReplaceRepeated permet aussi de limiter le nombre d’itérations de remplacement, ce qui
peut être pratique pour construire certains types de fonctions, comme par exemple :

ReplaceRepeated[1/(1+x), x -> 1/(1+x), MaxIterations -> 4]

On peut ajouter la fonction Quiet pour éviter l’affichage de messages :

Quiet[ReplaceRepeated[1/(1+x), x -> 1/(1+x), MaxIterations -> 4]]

7.6 Expressions
Tout objet en Mathematica (valeur, formule, graphique, ...) peut être mis en mémoire

dans une variable en utilisant l’affectation =
Exemple : fraction= x3+2x2−x−2

x3+x2−4x−4
Si on veut évaluer cette fraction pour une valeur de x donnée (par exemple 4), on peut

appliquer la règle x -> 4 à la variable fraction :

Quit
fraction = (x^3 + 2*x^2 - x - 2) / (x^3 + x^2 - 4*x - 4)
fraction /. x -> 4
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8 Annexe

8.1 Séparer deux notebooks
Par défaut, les expressions (variables, fonctions, ...) définies dans un notebook sont aussi

connues dans un autre notebook. Pour bien séparer deux notebooks on peut changer cette
option avec le Options Inspector :

1. Ouvrir le Options Inspector via (Ctrl + Maj + O) ou sous Mac OS X : (Cmd + Maj
+ O)

2. Dans le Options Inspector choisir tout en haut dans la liste nommée Show option
values, choisir Global Preferences

3. Chercher CellContext dans la case Lookup en dessous
4. Changer la valeur de CellContext en cliquant sur la flèche à droite de la valeur de

CellContext, puis choisir Notebook à la place de “Global”.
5. Pour finir appuyer sur le button Apply, puis fermer le Options Inspector.

8.2 Wolfram Alpha
Wolfram Alpha (www.wolframalpha.com) est un outil en ligne gratuit répondant à toutes

sortes de questions (qui doivent être posées en anglais) et qui utilise une grande base de
donnée et des calculs Mathematica. Il permet d’accéder avec un simple navigateur internet à
beaucoup de fonctionnalités de Mathematica. Par exemple, la demande "derivative of sin(x)"
(dérivée de sin(x)) calcule la réponse "cos(x)" et donne au passage d’autres informations utiles
(propriétés de la fonction, courbes, développements limités, etc...). A essayer !

12. Tester sur Wolfram Alpha les requêtes suivantes :
. derivative of sin(x)
. Plot sinus from 0 to 10
. UPMC

13. Un peu d’économie avec Wolfram Alpha, essayer les requêtes suivantes :
. GDP France (ici on peut changer l’échelle de logarithmique en linéaire)
. GDP Greece
. Unemployment Greece
. Unemployment young Greece
. Unemployment Portugal
. Unemployment Spain
. coal china production
. population of russia

8.2.1 Wolfram Alpha depuis Mathematica

Wolfram Alpha peut être interrogé directement depuis Mathematica avec une connexion
Internet.
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14. Dans un nouveau notebook (Ctrl + N) (voir en bas), taper :
== GDP France
Si un message d’erreur apparait c’est que la connexion Internet n’est pas bien configurée. Sur
les postes de l’UTES ou le bureau à distance de l’UTES il faut configurer Mathematica pour
qu’il puisse accéder à Internet : Dans Mathematica aller dans le menu Edit->Preferences
puis dans l’onglet Internet Connectivity choisir l’onglet Proxy Settings puis cocher
la case Use the following settings et entrer proxyweb.upmc.fr dans la case HTTP
Proxy et 3128 dans la case Port. Tester la connexion Internet avec le button Test Internet
Connectivity.
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